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Introduction and Installation

What is WiViK?

WiViK® is an on-screen keyboard that enables people 
with physical disabilities to access any application 
within Microsoft Windows XP/Vista/7. The WiViK  
keyboard is displayed within a window that you can 
move and size.

Pointing access
Using any pointing device (e.g., mouse, trackball, 
touchpad, and headpointer) you can select the WiViK 
on-screen keys. 

All keys work just as they would if you were typing on 
a physical keyboard. Select a key and WiViK sends it to 
a word processor, e-mail message, web page or other 
text-based application you may be using. Keyboards 
can contain any keys you want, can be moved 
anywhere on the screen and can be any size. WiViK also 
has a unique expanding quadrant keyboard for those 
with limited pointing abilities.

Scanning access
With switch-based scanning, a highlight moves 
or scans across the keyboard. Select the switch to 
choose the key you want and WiViK sends it to a word 
processor, e-mail message, web page or other text 
based application you may be using. With WiViK you 
can also use the switch to open menus, edit text, move 
or resize windows, jump to other applications or move 
the mouse pointer. 

While there are several standard scanning strategies 
available, WiViK also lets you define your own unique 
strategy based on your abilities and preferences. By 
choosing the number of switches (1 – 6), the basic 
scanning method (automatic, directed, inverse/step 
etc.) and the pattern of scanning movement you 
prefer (item, row/column, quadrant) you create your 
own personal scanning strategy which will make 
accomplishing your tasks easier and faster.

Word prediction and abbreviation-
expansion
WiViK includes WordQ® state-of-the-art word 
prediction and abbreviation-expansion that saves 
time and energy. Word prediction incorporates user 
vocabularies to predict which word is being typed. 
Begin typing a word. When it appears in the WiViK 
keyboard, choose it and WiViK will finish typing it for 
you. This way, there is no need to type the whole word. 
With abbreviation-expansion two or three letters can 
expand into phrases or full sentences. Both features 
help reduce the number of keystrokes needed for 
typing and can make writing more productive.

Text-to-speech
To help you with your writing and editing, you can 
have letters, words, and sentences spoken as you type. 
This helps you confirm that you have selected  the 
correct character, word, or combination of words and 
punctuation. 

A special reading mode allows you to proofread your 
text. When Microsoft Word, Outlook, WordPad, or 
Notepad is used, your text is highlighted and read 
word-by-word within the application. If you prefer to 
proofread at your own pace, you have the option to 
read a word or a sentence at a time. Web browsers and 
non-standard writing applications can also be read but 
without highlighting word-by-word.

Some applications will further allow Window items 
such as menus, lists, icons and buttons to be spoken as 
you use them.

Speech recognition
While not included with WiViK, WiViK ver. 3.2 and 
newer versions support the installation of SpeakQ® 
speech recognition plug-in to WordQ software. This 
can be purchased separately. WiViK keyboards are 
now included that feature the necessary SpeakQ 
control buttons. While SpeakQ is itself not a hands-free 
accessibility solution, it offers additional productivity 
gains for WiViK users who have speaking abilities.
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What you need to get started

To install and use WiViK, you need:

	 •	 A Windows® PC with 1GHz or higher processor 	
speed

	 •	 Windows® XP, Vista, Windows 7 (32/64-bit) 

	 •	 Sound card and speakers or a headset 

	 •	 USB port OR 15-pin joystick port which is 
typically found on your sound card. Connect 
either the PRC USB switch box or the PRC two-
switch connector.

WiViK software has been designed for individual PCs. 
Only one user may run a single copy of WiViK software 
at a time. However, that copy may be used by more 
than one user, each with a different user vocabulary 
file. 

Make sure that your Windows user account has 
administrator privileges before proceeding with the 
installation.

WiViK software may be installed directly on an 
individual PC or on a network with a separately 
licensed copy in each user’s network workspace (user 
drive) or on a standardized drive image (see Appendix 
C).  On a network, WiViK software must be installed by 
the System Administrator who must ensure the user 
has full read and write privileges within the \Program 
Files\WiViK subdirectory and the \Program Files\
WordQ2 subdirectory

INTRODUCTION AND INSTALLATION

Install from WiViK CD

1.	 Insert the WiViK software CD.

2.	 If the CD Autoplay feature is turned on, you will 
be prompted to choose Install WiViK or to cancel 
the installation.

3.	 If the CD Autoplay feature is turned off, view the 
contents of the CD by double-clicking on My 
Computer and then on the WiViK CD icon. Then 
double-click on the Setup.exe file.

4.	 Follow the online instructions that are presented.

5.	 The following software will be installed:

	 •	 WiViK® application 
•	 WordQ® 2 application  
•	 Acapela® Text-to-speech Engine (optional)

Backup

Keyboard settings and your vocabulary files are 
automatically saved whenever WiViK software is 
properly shutdown. You can also manually save your 
vocabulary files. 

Topic lists are included within your vocabulary but may 
be exported and saved as simple text files for sharing 
with other users. 

Typically, vocabulary files are stored within a 
subdirectory of the ...\WordQ2 directory.

Uninstall WiViK

Uninstall WiViK by using the Add/Remove Programs 
applet located in the Control Panel.
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Basic WiViK Operations

Using WiViK for the first time

1.	 Choose WiViK from the Start menu  
(Start>Programs>WiViK>WiViK) or double-
click the WiViK desktop icon created during 
installation.

	 A standard style keyboard is displayed the first 
time you use WiViK. This keyboard supports word 
prediction and contains most of the keys found 
on a physical keyboard.

2. 	 When you first use WiViK, you must create your 
own WordQ user vocabulary file to use with word 
prediction. This involves selecting the writing 
vocabulary that you want to use, and then 
naming your user vocabulary file. 

	 To learn how to create a new user vocabulary file, 
see Create a user vocabulary.

3.	 Start the application (e.g., word processor) that 
you want to use with WiViK.

If you intend to use WiViK frequently, consider 
adding WiViK and your word processing application 
to the StartUp folder so that they will run 
automatically when you start Windows.

4.	 Size and position WiViK and your application so 
that they do not overlap one another.

5.	 Select your application to make it active. Notice 
the WiViK keyboard remains on top. 

WiViK requires a document or application to be 
active to receive keystrokes. 

6. 	 Begin typing into your application by pointing at 
or clicking on the WiViK keys.

	 The selected characters will be typed into your 
document.		

Information about selection options and alternative 
methods for selecting keys are described in Click 
Selection, Dwell Selection, and Scanning Selection

7. 	 Select a predicted word by pointing and clicking 
on a desired word. If the word that you want is 
not shown, continue typing.

Closing WiViK

1.	 Select the WiViK keyboard and make its menu 
active. 

2.	 Select Exit under the File menu, or

	 Click the Close  button on the WiViK keyboard.

3.	 If you have loaded a different keyboard layout 
since the last time you quit WiViK, you will be 
prompted to save or ignore the change.

	 The next time you use WiViK, it will be restored to 
the state that it was last used. Information about 
the keyboard layout, position, and selection 
method is stored in the wivik3.ini file located in 
your \windows directory.

4.	 Your word prediction vocabulary and 
abbreviation-expansion set will also be stored.
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StickyKeys (Shift, Ctrl, Alt)

WiViK includes a “StickyKey” feature that enables you 
to type two or more keystroke combinations through 
single key selections. 

To type two keystroke  combinations

1.	 Select the modifier key (Shift, Ctrl, Alt) once if  
you want to combine it with another key. For 
example, the Alt key can be combined with a 
letter to pop-up a menu.

	 The modifier key remains selected until the key 
combination is completed. When the Shift key 
is selected, the keyboard displays uppercase 
characters. 

2.	 Select the key that follows the modifier key.

	 Depending on the key combination, an 
uppercase character is typed into your 
application, or an action is performed. The 
selection highlight is removed from the 
modifier key, and the keyboard returns to its 
original state.

To type multiple keystroke combinations

1.	 Select the modifier key (Shift, Ctrl, Alt) twice in 
a row if you want to hold it down for multiple 
keystroke combinations.

	 The modifier key remains selected. A small 
square appears in the bottom-left corner of the 
key to indicate that it is “latched.”

	

2.	 Select keys to combine with the modifier key. 
Each subsequent keystroke will be modified.

	 Depending on the key combination, an 
uppercase character is typed into your 
application, or an action is performed. The 
selection highlight remains until you unlatch the 
modifier key. 

3.	 To release the modifier key, select the key once 
again. 		

On top feature

When appropriate, the WiViK keyboard automatically 
hides behind other windows that you are using.  This 
ensures that the information you desire is always 
in view. Dialog boxes that are hidden by the WiViK 
keyboard are moved where they can be seen.	

To bring your document on top

1.	 If the WiViK keyboard partially covers your 
document, click on the title bar or border of your 
document window to bring it to the top. 	

2.	 Point within the keyboard area to return WiViK to 
the top.

To bring menus and dialog boxes on top

1.	 When the WiViK keyboard obscures a menu or 
dialog box, point to the menu or dialog box to 
bring it to the top. 

2.	 Point within the keyboard area to return WiViK to 
the top.

To bring WiViK back on top

	 When WiViK is partially hidden by another 
window, point within the keyboard area and 
WiViK will move to the top.

To always display WiViK on top

	 Select Always on Top under the Control menu.

	 This option ensures that the WiViK keyboard 
remains visible when another window is selected. 
Your keyboard remains on top and is never 
hidden behind other windows.

	  A check mark beside the Always on Top 
command indicates that this feature is active.

BASIC WIVIK OPERATIONS
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Choose a keyboard

A number of WiViK keyboards are available to you 
when you install WiViK. These keyboards contain 
different keys and layouts. When you use WiViK for 
the first time, the keyboard USENGLSH_TOP.kbp is 
active. This keyboard is generally used for typing and 
editing text, and contains most of the keys found on a 
physical keyboard. You may open more than one WiViK 
keyboard at the same time.

Types of keyboards
WiViK presently supports different types of keyboard 
files — standard international keyboards, macro 
keyboards, quadrant macro keyboards, and standard 
prediction keyboards.

Standard (.kbd)	
Standard keyboards are considered typical keyboards 
without word prediction keys. They are created with 
special key codes that should not be modified. 

Standard Prediction (.kbp)
Standard keyboards are considered typical keyboards 
with word prediction keys. They are created with 
special key codes that should not be modified. 

Macro	 (.kbm)
Macro keyboards contain functions that extend the 
standard keyboards. They can be customized for 
different applications or activities. For example, a 
macro keyboard may contain keys that control your 
word processing application, type entire phrases, or 
perform a combination of operations.

Quadrant (.kbq)
Quadrant keyboards are a variation of macro keyboards 
that have keys organized in quadrants. When a 
keyboard of this type is selected, the expanding 
quadrant selection method automatically becomes 
active. See Expanding Quadrant Selection.

To open a keyboard

1.	 Select Open Keyboard... under the File menu.

2.	 Locate and select a keyboard file from either ...\
wivik\standard or ...\wivik\macro subdirectory

Change international settings

WiViK has a number of international keyboards that 
allow you to select characters unique to a language. 
When using an international keyboard, you must select 
the appropriate Windows keyboard and input locale 
setting for that language. Keyboard properties are 
located in the Windows Control Panel.  

To change settings in Windows XP

1.	 Open the international WiViK keyboard that you 
want to use.

2.	 Select Start>Control Panel>Regional and 
Language Options.

3	 From the Language page, select the Text 
services and input languages>Details... button 
to set the appropriate language and keyboard 
layout.

4.	 To specify the language that you want to use 
whenever you start up Windows, select the 
language and then the Set as Default button.

5.	 Press Enter or click OK when done.

BASIC WIVIK OPERATIONS
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Your WiViK Keyboard

Choose a font

You can change the type and style of font that appears 
on the labels of your keys.

Changing the font in WiViK does not change the font used 
by your application.

To change the font of the key labels

1.	 Select Font... under the Customize menu.

2.	 Select the type and style of font from the Font 
dialog box.

	 	

Hide/Show the menu and title bars

To hide or show the menu bar

1.	 Select Hide Menu Bar under the Control menu to 
hide the menu bar.

2.	 Select Show Menu Bar under the Control menu 
to show the menu bar.	

To hide or show the title bar

1.	 Select Hide Title Bar under the Control menu to 
hide the title bar along with the menu bar. 

	

2.	 Double-click any border to show the title bar.
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Enable key selection feedback

Select Key Click... under the Customize menu to 
enable a key clicking sound that confirms a key 
selection.

Adjust the appearance

	 Select Display Options... under the Customize 
menu. 

	

To adjust the keyboard spacing

	 	Select None, Small, Medium, Large, or Extra 
Large to set an appropriate key spacing.

To choose color or high contrast display 

	 	Select Color or High contrast to alternate 
between keyboard display modes. The high 
contrast mode displays white keys with black 
text.

To choose key shape

	 	Select Round corners or Square corners to 
change the key shape.

To lock the window size and position

	 	Lock size of keyboard. Select this to lock 
WiViK's window so that it is not accidentally 
re-sized; otherwise you can freely size WiViK by 
dragging any border.

	 	Lock position of keyboard. Select this to 
lock WiViK's window so that it is not accidentally 
moved; otherwise you can freely move WiViK by 
dragging its titlebar.
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Click Selection

	 	Highlight keys that you click. This is the 
typical mode where a key is highlighted when 
you first push down on a button or switch. If you 
move off the key while still pressing down, the 
highlight goes away and if you then release the 
button no key will be selected.

	 	Highlight keys while dragging. This is a 
typical mode for a touchscreen user. Keys are 
highlighted as you drag over them and selected 
when you release the button.

	 	Highlight keys while pointing or dragging. 
Keys are highlighted as you point or drag over 
them. Keys are selected when you release the 
button.

To enable additional click options

	 Click one or more check boxes to enable the 
following additional options.

	 	Double-click to shift/capitalize a key. This 
enables you to quickly shift keys from lower to 
uppercase by double-clicking on a key with your 
button or switch.

	 	Select key on click down.  This is available 
if you choose Highlight keys that you click. 
It is useful if you want to send a keystroke 
immediately upon activating the button when 
there is a delay before the button is released. 
Some sip and puff switches may have such a 
delay.

Repeating keys are not available with the Click 
selection method.

Enable click selection

Click selection allows you to point to a key and activate 
a pointing device's button or switch to indicate your 
selection.

To enable click selection method

1.	 Select Click from the Select menu.

2. 	 It is suggested that Key Click under the 
Customize menu is enabled to provide auditory 
feedback as you select keys. 

Set click options

There are several options that you can set to enhance 
the use of click selection. Select Options under the 
WiViK Select menu; then set your desired options.

To change the way keys are highlighted

	 Select the radio button indicating the desired 
highlighting mode in the Click Options dialog.

	



13   	

Dwell Selection

To enable additional dwell options

	 Click one or more check box to enable the 
following additional options in the Dwell 
Options dialog.

	  Predict the desired key when pointing is 
unsteady. This special function averages the 
dwelling time to make it easier to select a key if 
your pointing is imprecise or you have a slight 
tremor. This means that you can move off and on 
a key during the dwell time period; the key that is 
dwelled on for the total amount of time equal to 
the dwell time will be selected.

	  Allow key to repeat. This allows a key to 
be repeated by continuing to dwell over it. The 
repeat rate equals the dwell time.

	  Stop repeating key when mouse is 
motionless. This is used along with the auto 
repeat function. If the cursor remains perfectly 
still, that is, when you are no longer in contact 
with the pointing device, the auto repeat is 
inactive.

Enable dwell selection

Dwell selection allows you to point to a key and select 
by pausing or dwelling for a specified period of time. 

To enable dwell selection method

1.	 Select Dwell from the Select menu.

2. 	 It is suggested that Key Click under the 
Customize menu is enabled to provide auditory 
feedback as you select keys.

Set dwell options

There are several options that you can set to enhance 
the use of Dwell selection. Select Options under the 
WiViK Select menu; then set your desired options.

To adjust the dwell time

	 Slide the Dwell time scroll bar in the Dwell 
Options dialog to adjust the dwell time. 
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Scanning Selection

Switch connection

This dialog specifies how the switches are connected. 
Initially, the  F11 and F12  keys are selected instead of 
switches. You will need to change the interface setting 
for the particular switch connection you are using. Test 
the switches in this dialog. As you press a switch, the 
corresponding switch number will highlight.

	

Enable scanning selection

Scanning selection allows you to select WiViK keys to 
type and manipulate the Windows interface using 1–6 
switches.

1.	 Select Scan from the Select menu.

Set scanning options

1.	 Select Options from the Select menu after 
choosing Scan as the selection method.

	

2.	 It is suggested that you set scanning options in 
the following order.

	 Choose switch interface connection.

	 Select number of switches.

	 Choose automatic, inverse or directed scanning 
method.

	 Select highlighting style with automatic and 
inverse scanning.

	 Assign specific actions to switches.

	 Set timing options.

	 Set scanning preferences. 



15   	

Scanning methods

Automatic
In automatic scanning, groups or items are 
automatically highlighted or scanned in sequence. The 
highlight pauses at each group/item for a preset time. 

When you activate (press and release) the select switch,  
scanning begins across smaller groups or individual 
items. If you click the select switch when an individual 
item is highlighted, that item is selected. One or two 
switches are usually used with automatic scanning with 
select and cancel actions assigned to switches.

You must be able to activate the switch within the 
preset time to make a selection.

Inverse
With inverse scanning you advance the highlight by 
holding the select switch down. While the switch is held 
down, the highlight pauses at each item for a preset 
time.

Step scanning is a variation where you advance by 
repeatedly activating the select switch. Sometimes, step 
and inverse scanning are combined.

The advantage of inverse/step scanning is that timing 
is not as critical as with automatic scanning. Groups or 
items are selected with a select switch or by dwelling. 
Typically two or three switches are used with move, 
select and cancel actions assigned to switches.

Directed
Directed scanning matches separate switches with 
moving the highlight across individual keys. These 
switches are used in a step or inverse fashion. 

The switches are often housed in a gated joystick, 
allowing users to direct the scanning cursor as they 
would drive an electric wheelchair. Items are selected 
by activating the select switch, or by dwelling for some 
period. Directed scanning requires the greatest degree 
of control.

Highlighting styles

Row-column
Rows of items are highlighted from the top down one 
at a time. A selected row is then highlighted column-
by-column (item-by-item) until the desired item is 
reached and selected. The highlighting returns to the 
first row after a selection.

Row-group-item
Groups of items in a selected row are highlighted 
until a group containing the desired item is selected. 
Then items within that group are highlighted until the 
desired item is reached and selected. The highlighting 
returns to the first row after a selection.

Column-row
Columns of items are highlighted one at a time. A 
selected column is then highlighted row-by-row (item-
by-item) until the desired item is reached and selected. 
The highlighting returns to the first column after a 
selection.

Column-group-item
Groups of items in a selected column are highlighted 
until a group containing the desired item is selected. 
Then items within that group are highlighted until the 
desired item is reached and selected. The highlighting 
returns to the first column after a selection.

Quadrant scanning
The keyboard is divided into quadrants. Each quadrant 
is highlighted in succession. Sub-quadrants within a 
selected quadrant are highlighted and the process 
continues until individual items are highlighted.

Item scanning
Each item is highlighted one at a time, usually from left-
to-right and top-to-bottom until an item is selected. 
After a selection, highlighting begins again with the 
first item and repeats scanning. Element scanning is 
typically limited to less than 15 items.

SCANNING SELECTION
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Automatic switch actions

For each available switch, assign an appropriate action 
after choosing Actions from the Scanning Options 
dialog.

At least one switch must be defined as a Select switch. You 
can repeat a key by holding down he Select switch.
	

	

Select	 Starts scanning initially; makes 
selection of row/column, group, or 
item; repeats selection if switch is 
held down.

Cancel	 Stops scanning; control is switched to 
the next open WiViK keyboard when 
switch is activated twice in a row.

Overdrive	 Advances the highlight faster 
according to Time adjusted by the 
Speed Factor while switch activation 
is maintained.

2 Speed	 Toggles between scan Time and scan 
Time adjusted by the Speed Factor.

Move/Reverse	 Toggles direction of scanning.

Inverse switch actions

For each available switch, assign an appropriate action 
after choosing Actions from the Scanning Options 
dialog.

At least one switch must be defined as a Move-style 
switch. You can repeat a key by holding down the 
Select switch. If a Select switch is not defined, keys are 
automatically selected by dwelling.

Select	 Selects item.

Cancel	 Stops scanning; control is switched 
to the next available scanning WiViK 
keyboard when switch is activated 
twice in a row.

Overdrive	 Modifies speed associated with Move 
switch according to Time adjusted by 
the Speed Factor.

Move, Reverse	 Advances highlight when you hold 
the switch down or repeatedly 
activate the switch.

Move fast, Reverse Fast   Advances highlight when you 
hold this switch down using the scan 
Time adjusted by the Speed Factor.

Move 2 speed, Reverse 2 Speed   Advances highlight 
when you hold the switch down using 
the standard scan Time interval until 
you release the switch; then when 
you next hold down the switch the 
highlight advances according to the 
Time adjusted by the Speed Factor; 
this action toggles.

Move/Reverse	 Advances highlight when you hold 
the switch down until the switch is 
released; moves highlight in reverse 
direction when you next activate the 
switch; this action toggles.

Move/Rev fast	 Advances highlight when you hold 
the switch down using the scan 
Time adjusted by the Speed Factor 
until you release the switch; moves 
highlight in reverse direction when 
you next activate the  switch; this 
action toggles.

SCANNING SELECTION
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Timing settings

Timing is the most important aspect of scanning 
access. WiViK incorporates several timing settings that 
accommodate wide ranging abilities. All are based on the 
setting of a basic scan interval.
	

The following timing settings are set within each 
scanning strategy.

	 Time. This is the time interval that the highlight 
pauses at one location before advancing while 
switch activation is maintained; also, the time 
interval between repeating keystrokes. This 
should be set so that you can hit or release the 
switch before the highlight passes the desired 
row, group or item. When step scanning is used, 
this should be set high so that the highlight does 
not advance over more than one item with each 
hit. 

	 This time also controls the repeat time when 
you hold down the select key beyond the Delay 
Factor. The repeat function works as follows: 
Delay Factor—1st selection—Delay Factor—2nd 
selection—Delay Factor at Scan/Repeat time.

	 Delay Factor. Increases the Time of the first 
group or item scanned by this factor. This gives 
you a chance to seek out the next item for 
selection. Typically this is set to 2.

Directed switch actions

For each available switch, assign an appropriate action 
after choosing Actions from the Scanning Options 
dialog.

At least two switches must be defined for horizontal and 
vertical movement. You can repeat a key by holding down 
the Select switch. If a Select switch is not defined, keys are 
automatically selected by dwelling.

Select	 Selects item.

Cancel	 Stops scanning; control is switched 
to the next available WiViK keyboard 
when switch is activated twice in a 
row.

Right, Left, Up, Down Moves highlight in the switch 
direction when you hold the switch 
down or repeatedly activate the 
switch.

Right, Left, Up, Down Fast  Moves highlight in the 
switch direction when you hold the 
switch down using the scan Time 
adjusted by the Speed Factor.

Right/Left	 Moves highlight in the switch 
direction when you hold the 
switch down; moves highlight in 
the opposite direction when you 
next activate the switch; this action 
toggles.

Right/Left Fast Up/Down Fast   Moves highlight in 
the switch direction when you hold 
the switch down using the scan 
Time adjusted by the Speed Factor 
until you release the switch; moves 
highlight in the opposite direction 
when you next activate the switch; 
this action toggles.	

SCANNING SELECTION
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	 Speed Factor. Decreases the Time by this factor 
when using a switch defined as Overdrive, 2 
Speed, or Fast. It allows you to quickly move to the 
approximate location of the desired row, group 
or item. Typically Speed Factor is set to 2 or 3. 
You must stop before reaching the target.

	 Dwell Factor. Increases the Time by this factor 
to  dwell or wait to make a selection or to cancel 
scanning. If no Select switch is defined, selection 
is automatically set to dwelling. Dwell Cancel is 
only available when a Select switch is defined. 
Typically Dwell Factor is set to 4 or 5 for dwell 
selection and 6–10 for dwell canceling.

	 Debounce Time. The time that the user must 
hold down a switch to activate it. It prevents 
double activations of the switch caused by 
bouncing on the switch or poor contacts within 
the switch. 

Automatic preferences

	

	  Scanning sound. If checked, the computer 
beeps with every movement of the highlight.

	  Invisible cancel.  If checked, there is an 
added scan interval at the end of a cycle (e.g., 
row) where nothing is highlighted. When the 
selection switch is activated, scanning stops if 
Scan continuously is not checked, otherwise 
scanning returns to the top level. (Used when a 
separate cancel switch is not available.) 

	  Scan continuously. If checked, the scanning 
continues after any selection, otherwise scanning 
stops when a single item is selected.

	  Scan right-to-left. By default, the highlight 
scans left-to-right; this may be changed to right-
to-left orientation.

	 Scan cycles. This adjusts the number of times 
that the highlight cycles through a group (e.g., all 
rows) before stopping and disappearing; if set to 
0 then the highlight cycles indefinitely.

SCANNING SELECTION
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Inverse preferences

	

	  Scanning sound. If checked, the computer 
beeps with every movement of the highlight.

	  Scan right-to-left. By default, the highlight 
scans left-to-right; this may be changed to right-
to-left orientation.

	 Scan cycles. This adjusts the number of times 
that the highlight cycles through a group (e.g., all 
rows) before stopping and disappearing. If set to 
0 then the highlight cycles indefinitely.

Directed preferences

	 	
 Scanning sound. If checked, the computer 
beeps with every movement of the highlight.

	  Scan right-to-left. By default, the highlight 
scans left-to-right. This may be changed to right-
to-left orientation.

	 	Select either Corner of keyboard or Center 
of keyboard to indicate where the highlight will 
start scanning.

	  Return to starting position after selection. 
If checked, the highlight returns to its starting 
position after every selection.	

	 	Select scan to the next line, scan the same 
line, or none to indicate how the highlight 
continues when it reaches the end of a line.

SCANNING SELECTION
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Use word prediction

To select a predicted word
Select a predicted word as you would any other key.

Undoing a wrong selection
If you select the wrong word by mistake, you can 
quickly correct it by pressing Esc. The last word will be 
erased and you can now select the correct word.

Choosing different word endings
Sometimes only part of a word you want is predicted, 
e.g., “start” rather than “starting.”  You can easily see 
different endings:

1.	 Select the partial word, e.g., “start.”

2.	 Press Backspace. Variations of that word with 
different endings will appear. 

3.	 Make your selection.

Working with in-context prediction
Wherever you position the text cursor in your 
document, WordQ will show you appropriate 
predictions, even when the cursor is in the middle of a 
word. 

Experiment with moving the cursor through a word to 
see how the predictions change. This feature is really 
useful to see different word endings.

If you type a letter within an existing word, the 
predicted words will be based on the letters that 
came before, including the one just typed. Selecting a 
predicted word will replace the existing word. Double-
click or highlight a word to have it spellchecked.

Word Prediction

About WordQ word prediction

WiViK incorporates WordQ technology for its word 
prediction. WordQ is a separate application that runs 
at the same time as WiViK and displays predicted 
words within WiViK on-screen keyboards. As you type, 
correctly spelled words are continuously displayed. 
When you see the word you want to use, you can 
choose it with your pointing device or switch. You can 
also display a word with its different word endings. 
Using knowledge about the last word that you wrote, 
WordQ software also suggests relevant next words in 
your sentence.

A user vocabulary reflects your personal writing style. 
This user vocabulary continually adapts as you write 
and improves its performance as you use it. This 
vocabulary ensures words are suggested that you 
regularly use and understand, thus reducing confusion. 
A number of initial user vocabularies are included 
based upon starting, intermediate, and advanced 
writing styles. You can further customize your user 
vocabulary by adding novel words and by importing 
text files. 

You can also create and use groups of words called 
topics, such as your favorite sport, the family pet, or 
general math concepts. When you write about one of 
your topics, its words are more likely to be suggested.

When WordQ encounters unfamiliar and misspelled 
words, it saves them for you to review at a later time. 
You can then delete a misspelled word or add a novel 
word to your vocabulary. 
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	 Standard Core: This template is used when you 
want to start with a limited number of words. It 
includes function words, days, months, numbers, 
colors, and provinces or states. 

	 Function Word Core: This template is used when 
you want to start with a profile that contains 
function words only. This template includes 
about 500 function words.

3. 	 Enter a filename, such as your own name, to 
create a user file. Your user file will contain a copy 
of the vocabulary and selected options will be set 
for you..

4. 	 If you wish, you can modify your vocabulary and 
settings, or allow WordQ to adapt to your writing 
style.

You can have more than one user vocabulary.

Open another user vocabulary

1.	 Select Open User... from the WordQ Options 
menu.

2. 	 Select a user vocabulary name and press Open.

3. 	 You will then be asked whether you want to 
save any changes to the previous user file before 
opening the selected user file. 

Create a new user vocabulary based on the 
current user vocabulary

1.	 Select Save User As... from the WordQ Options 
menu.

2. 	 Type a different user name and press Save.

3. 	 The vocabulary and settings from the existing 
user vocabulary will be copied to the new user 
vocabulary. You can modify these as necessary.

Copying a WordQ vocabulary to a different 
computer
The WordQ vocabularies are stored by default in the  
...(My) Documents/WordQ 2 Users folder. There are 
two files: one with the extension .nwp and the other 
with .wdq. You can copy any of these files to a flash 
drive, CD, or move them over a network. On the 
new computer place the files in the WordQ 2 Users 

Using creative spelling
WordQ will consider creative spelling when making its 
predictions. Whenever there are no words in WordQ’s 
dictionary beginning with the letters that you type, 
WordQ will suggest words that take into consideration 
possible spelling/typing mistakes. Also, when you 
highlight a word, creative spelling will be considered 
when predicting words, i.e., spellchecked.

You can turn this feature off by unchecking:  
WordQ Options>Predictions...>Predictions: Predict 
words based on creative spelling.

Managing Vocabularies

WordQ allows a single user to have multiple 
vocabularies or multiple users may use WordQ with 
their own vocabulary. You can also specify how new 
words are handled.

To access the user vocabulary features, you must first 
display the WordQ Options menu and button bar by 
selecting the Options button  on the WiViK on-
screen keyboard. 

Create a new user vocabulary

1. 	 Select New User from the Options menu on the 
WordQ button bar.

2. 	 Choose a vocabulary that matches your writing 
level. This is only a starting point — WordQ 
adapts to your own writing as you use it.

	 Starter: This vocabulary is for people who are 
starting to write. It includes about 5,000 words 
commonly used by writers up to grade 3 level.

	 Intermediate: This vocabulary is for people who 
are writing at an intermediate level. It includes 
about 10,500 words commonly used by writers 
at a grade 2 to 8 level.

	 Advanced: This vocabulary is for people who are 
writing at an advanced level. It includes about 
15,000 words commonly used by writers at a 
grade 7 level and above.

	 Blank: There are no words associated with this 
template. This template is used when you want 
to create your own list of words, rather than start 
from one of the other vocabularies. 
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folder, and in WordQ select Open User... from the 
Options menu to load the vocabulary.To create a user 
vocabulary based on the current user vocabulary

Create a user vocabulary with specific 
vocabulary needs
You may want to limit your writing vocabulary to the 
words that you know, or a specific set of words that you 
are learning

Limited vocabulary

1.	 Select New User... from the WordQ Options 
menu.

2. 	 Begin with the Blank, Standard Core or Function 
Word Core.

3. 	 Add your own words to your vocabulary, and 
remove any words you do not want to use. 

Keep your vocabulary from learning new words

1. 	 Select Prediction... from the WordQ Options 
menu.

2. 	 Select the Prediction tab.

	 • 	 Uncheck Predict new words that I use

	 • 	 Uncheck Adapt predictions based on how I 
combine words

Predict words from only your vocabulary 

1. 	 Select Prediction.... from the WordQ Options 
menu.

2. 	 Select the Prediction tab.

	 • 	 Uncheck Predict words from the WordQ 
Dictionary

Delete a user vocabulary

1. 	 Select Open User... from the WordQ Options 
menu.

2. 	 Select a user vocabulary file name from the 
Open... dialog box and press the Delete key on 
your keyboard.

Getting the best predictions

WordQ allows you to customize your vocabulary to get 
the best predictions for different situations.

You can improve word prediction by:

	 • 	 Expanding your vocabulary by adding new 
words one-at-a-time or by having WordQ learn 
from existing files

	 • 	 Focusing your vocabulary for a specialized 
writing project by using topics

	 • 	 Limiting your vocabulary by beginning with a 	
blank vocabulary (usually for a young learner)

Expanding your vocabulary:  
Family, friends and special words
It is a good idea to add personal words or phrases to 
your WordQ vocabulary such as the names of family 
and friends. 

1.	 Select My Words... from the WordQ Options 
menu.

2. 	 Type a word or short phrase (up to 30 letters) in 
the New Word box and then select Add or press 
Enter. 

	 You may add any number of words that you want. 
Be careful with your spelling, as words are not 
spellchecked now. If the word is already in the list, 
it will be highlighted for you.

3. 	 Select Close when done.

Expanding your vocabulary:  
Learn from existing documents
You can quickly expand your vocabulary by having 
WordQ learn words and their usage from existing 
documents. 

For example, you can have WordQ learn from articles 
that you may be reading on the Internet. The first step 
is to copy those articles into a word processor or text 
editor such as Notepad. You must then save the file in 
a text-only format (*.txt). You may also learn from past 
documents you have written that are re-saved in a text-
only format.

1.	 Select My Words... from the WordQ Options 
menu.

.
WORD PREDICTION
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2.	 Select the Learn... button. This displays an Open 
dialog box.

	 Locate the directory where your text file (*.txt) is 
located, and open the desired file to learn.

	 WordQ will learn the words in that file and update 
your vocabulary.

	 Words will be checked for proper spelling, and 
misspelled and unknown words will be set aside. 
See Go over misspelled and unknown words 
below.

3. 	 Repeat with as many files as you like. 

4. 	 Click Close when done.

Focusing your vocabulary: 
Topics for specialized writing
You can emphasize words in the prediction by using 
topics. A topic is a list of words that are part of your 
vocabulary that will be predicted faster.

When you first use WordQ, a sample baseball topic is 
available for you to try out. 

Topic words are best written out in advance using a 
word processor or Notepad and saved in text-only 
(*.txt) format. Enter only one topic word or short phrase 
(up to 30 letters) per line. Ensure that these words are 
correctly spelled as they will not be spellchecked by 
WordQ. The folder ...\WordQ2\Topics initially contains 
sample text files for different topics that you may find 
useful.

To use a particular topic

1. 	 Use your mouse to point to and select a topic 
from the dropdown list in the WordQ button bar 
or press F12, followed by  to move through the 
list and Enter to select topic.

2. 	 Click back in your writing application and return 
to typing.

3.	 You will notice that topic words are predicted 
faster.

To turn off a topic

1. 	 At any time choose another topic, or choose 
<none> as a topic if you don’t want any topic.

2. 	 Click back in your writing application and return 
to typing.

To create a topic list

1.	 Select My Words... from the WordQ Options 
menu. Then click the Topics tab.

2. 	 Click on the New... button.

	 Type in a Topic Name and press OK in the pop-up 
dialog.

3. 	 Add words one-by-one or from a text file as 
described below.

To add topic words one-by-one

1. 	 Type a word or short phrase (up to 30 letters) in 
the New word box and click Add or press Enter.

	 The word will be copied to the list and placed in 
alphabetical order.

2. 	 Repeat for all topic words.

To add topic words from a text file

1. 	 Select the Add From... button. This will display 
the Open dialog box.

	 Browse to the directory where your topic file is 
located and select it. The directory (...\WordQ2\
Topics\) contains sample topics saved as text files 
(*.txt). 

2. 	 Your words in the file will be added to the current 
topic and automatically become part of your 
vocabulary (without being spell checked).

Limiting your vocabulary: 
Beginning with a Blank vocabulary
Beginning with a Blank vocabulary is a useful way to 
have a very limited set of words predicted that will not 
confuse you.

1.	 Select New User... from the WordQ Options 
menu.

2.	 Select a Blank vocabulary and save it with a 
descriptive name such as a lesson name.

3.	 Now select My Words... from the WordQ Options 
menu. Note that the vocabulary list is blank.

4.	 Type in any new words that you want to use.

	 Select Add or press Enter after each word that 
you type to add it to the vocabulary list. When 
done, select Close.

WORD PREDICTION



24   	

5.	 Select Prediction... from the WordQ Options 
menu. Then click the Prediction tab. 

	 Uncheck all options under Word Prediction: Choose 
your prediction options. This will ensure that no 
additional words will be predicted.

6. 	 Click OK when done.

Going over misspelled and unknown 
words

Misspelled and unknown words are put aside for you to 
review. They will not be predicted until you specifically 
add them to your vocabulary.

Select My Words... from the WordQ Options menu.
Then click the Spelling tab. 

You will see a list of words that may be misspelled or 
not found in the WordQ Dictionary such as proper 
names and acronyms. Review this list of words for 
proper spelling.

1. 	 Select the words you would like to add to your 
main vocabulary. 

	 You can select a range of words with the 
common Windows Shift+click action. Select 
separate words with Ctrl+click.

2. 	 Click the Add to Main button to add the selected 
words to your vocabulary. These words will now 
be used in word prediction. 

3.	 Any remaining words can be deleted with the 
Delete button after selecting them so that you 
don’t have to review them again.

4. 	 Click Close when done.

WORD PREDICTION
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Abbreviation-Expansion

Create and edit abbreviation-
expansions

Select My Words... from the WordQ Options menu. 
Then click the Abbreviations tab.

	

To add abbreviation-expansions one-by-one 

1. 	 Click on the New... button.

2. 	 Type in an abbreviation and press OK in the pop-
up dialog.

3.	 The word will be entered in the list of 
abbreviations in alphabetical order.

4.	 Type the expanded text for the abbreviation in 
the Expansion box.

5. 	 Repeat for all abbreviation-expansions.

Use CTRL+Enter to add a line in an expansion.

About WordQ abbreviation-expansion

WiViK incorporates WordQ™ technology for its 
abbreviation-expansion. Abbreviation-expansion 
is a technique in which a combination of letters, an 
“abbreviation,” is used to represent a word or phrase. 
When you type an abbreviation followed by the 
Spacebar or Enter key, it expands to the assigned word 
or phrase.

You can create your own set of abbreviations that are 
easy for you to use and remember. There is no limit on 
the number of abbreviations that may be saved in one 
set. Because you must memorize each abbreviation, 
a small set of abbreviations is suggested. A sample 
abbreviation-expansion set is available for you to use 
to get started.

Your abbreviations will be caught as possible 
misspellings and held in the Spelling dialog 
(Options>My Words...>Spelling). You can choose 
to add them to your prediction vocabulary so 
that they will appear as predicted words. This can 
reduce keystrokes as well as be a helpful memory 
cue, especially with abbreviations of three or more 
characters.

 A suggestion is to begin your abbreviations with the 
letter “x” so that they are obvious abbreviations.

Use abbreviation-expansion

To turn abbreviation-expansions on and off
Select Abbreviations from the WordQ Options menu 
or from the WiViK Tools menu.

To use an abbreviation-expansion
You can use an abbreviation at any time. Just type the 
abbreviation followed by a space, and the expanded 
text will be typed in its place.
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To add abbreviation-expansions from an 
external file

1. 	 Select the Import... button. This will display the 
Open dialog box.

2. 	 Browse to the directory where your abbreviation-
expansions file (*.abb) is located, and then select 
your file.

3. 	 Your words in the file will be merged with your 
current abbreviation-expansions. 

To save abbreviation-expansions to an 
external file

1. 	 Select the Export... button. This will display the 
Save As dialog box.

2. 	 Browse to the directory where you want to save 
your abbreviation-expansion file. 

3. 	 Give your file a name. 

4. 	 Your abbreviation-expansions will be saved in a 
specialized file with the extension ".abb" that can 
be opened in another user's vocabulary or on 
another computer.

ABBREVIATION-EXPANSION

To delete abbreviation-expansions

1. 	 Select words by clicking on them. Select a range 
of words with the common Windows Shift+click 
action. Select separate words with Ctrl+click.

2. 	 Click the Delete button to remove selected words 
from the list. 

To include non-alphabetic keystrokes into an 
expansion
You may include non-alphabetic keystrokes into an 
expansion by typing the appropriate keystroke code as 
shown below:

	 Code	 Keystroke

	 <SHIFT>	 Sticky Shift

	 <CTRL>	 Sticky Ctrl

	 <ALT>	 Sticky Alt 	

	 <ENTER>	 Enter/Return

	 <ESC>	 Escape (Esc)

	 <BKSP>	 Backspace

	 <TAB>	 Tab

A complete list of available keystroke codes is 
available in Appendix C.
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Speech Feedback

To read a sentence in Notepad, WordPad, Microsoft 
Office

1. 	 Position the text cursor anywhere in the 
sentence.

2. 	 Press the Read button. 

3. 	 The sentence will be highlighted and the 
prediction box will temporarily disappear.

4. 	 Press Spacebar to begin reading the sentence. 
Each word is highlighted as it is spoken. Listen for 
any mistakes. 

	 • 	 Press Spacebar to pause/resume reading

5. 	 The sentence is highlighted again after it has 
been read.

6. 	 You may then:

	 • 	 Read individual words to locate specific errors 
by repeatedly pressing  or 

	 • 	 Press the Esc key or click in the text to resume 
writing and make corrections

	 • 	 Read the sentence again by pressing Spacebar

	 • 	 Go to the previous or next sentence by 
pressing  or 

To read a block of text

1. 	 Highlight the block of text to read.

2. 	 Press the Read button.

3. 	 The text is read immediately. Each word is 
highlighted as it is spoken. 

	 • 	 Press the Esc key at any time to stop reading

To read in Web browsers and non-Microsoft programs

1. 	 Select the text to read. In a Web browser or 
Adobe® Acrobat Reader®, use your mouse or 
equivalent to select text by dragging over it.

2. 	 Press the Read button.

3. 	 The text will be spoken immediately.

	 Press the Esc key at any time to stop reading.

Turn speech on and off

Press the Speech button  to toggle speech on/off.

If there is no sound from your speakers, please ensure 
that they are connected and powered on. Also, ensure 
that the volume is adjusted both on the speakers and 
in Windows.

Change voice settings

You may change various settings that affect how the 
reading voice sounds.

Select Speech Feedback... from the WordQ Options 
menu.

Typing echo

You can have letters, words, and sentences spoken as 
you type. Any combination of these may be used.

Select Speech...>Feedback from the WordQ Options 
menu.

Proofreading your work

WordQ offers a special proofreading mode if you are 
using Microsoft Word, WordPad, Notepad, or Outlook. 
Here the current sentence is spoken with each word 
highlighted word-by-word emphasizing the visual/
spoken shape of each word. All of this is done directly 
in the application. 

If you hear a mistake you can then step through the 
sentence word-by-word to locate the mistake. For 
example, you may hear two words that sound wrong 
together. You may have left a word out in between or 
one of the words may be incorrect. 

When other applications are used (e.g., WordPerfect®, 
Internet Explorer®, or Inspiration®), word-by-word 
highlighting is not available and you must manually 
highlight the text. 
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Numbers and punctuation

To display the numbers and punctuation 
page

1.	 Select @123... on the initial letters page.

2.	 You will automatically return to the initial letters 
page after selecting any punctuation.

Function keys

To display the function keys page

1.	 Select F1... on the initial letters page.

2.	 You will automatically return to the initial letters 
page after selecting any function key.

Scanning the Desktop

Scanning keyboard: Crnfreq.kbm

WiViK includes several keyboard layouts that are 
appropriate for various scanning strategies. They 
include commands to scroll, resize and move windows, 
scan menus, position the text cursor, and emulate 
mouse movements.

The keyboard crnfreq.kbm is the most commonly 
used scanning keyboard. It has been designed for 
row/column scanning with letters arranged so that 
frequently used letters are close to the upper left-
hand corner. This keyboard, described in detail here, 
illustrates the features of a scanning keyboard.

All scanning keyboards include the same features 
described here, although the layout of keys varies. All 
of these are located in the subdirectory ...\WiViK\macro 
and are shown in Appendix A.

Shift/upper case

To shift keys

1.	 Select  once on the initial letters page to shift 
the next letter. (Select Sh on the initial letters 
page on the keyboards linabc.kbm, linabc2.kbm, 
linfreq.kbm, and linfreq2.kbm)

2.	 Select  twice on the initial letters page to hold 
down the Shift key. Select  again to release 
Shift. Shifted keys are not displayed as upper 
case.
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2.	 Select a desired movement key such as Scan right 
by words. 

	

3.	 The text insertion cursor will begin scanning 
and highlighting the text by words. If you are 
using Inverse or Directed scanning, a Move or 
Direction switch advances one scan step.

4.	 Stop scanning the text with the Select switch.

5.	 Stop highlighting the text with the Stop Extend 
Select icon. 

Key descriptions 

 	 	 Scan right by characters

 	 	 Scan right by words

	 	 Scan down by lines

 	 	 Scan down by paragraphs  
(limited to applications that use Ctrl + 
  to move to next paragraph)

	 	 Scan left by characters

	 	 Scan left by words	

	 	 Scan up by lines

	 	 Scan up by paragraphs  
(limited to applications that use Ctrl +  
  to move to previous paragraph)

	 	 End of line

Text cursor movement

Moving the text cursor is an essential part of editing. 
WiViK includes keys to move the text cursor across your 
text in a scanning fashion.

When you choose a text movement key, the text cursor 
begins scanning across the text. Stop scanning with the 
Select switch. Then choose another key if necessary. 
It is best to scan first by larger increments and then 
successively smaller increments. When “extending” a 
selection, the end point of the selected block appears 
to be scanning.

To move through your text

1.	 Select the text cursors page icon. 

	 A new WiViK page will be displayed containing 
cursor  movement keys.

2.	 Select a desired movement key such as Scan right 
by words. 

	

3.	 The text insertion cursor will begin scanning 
the text by words. If you are using Inverse or 
Directed scanning, a Move or Direction switch 
advances one scan step.

4.	 Stop scanning the text with the Select switch.

To highlight your text

1.	 Select the Extend Select icon to begin 
highlighting your text. 

	

	 A new WiViK page will be displayed containing 
cursor  movement keys that will highlight text.

SCANNING THE DESKTOP
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To speed up scanning

1.	 Select Faster on the Text Cursors page and the 
scan interval will decrease by 0.25 secs. 

To slow down scanning

1.	 Select Slower on the Text Cursors page and the 
scan interval will increase by 0.25 secs. 

Scanning mouse

While WiViK provides ways to directly scan menus, text 
cursors, scroll bars, and windows, some applications 
(e.g., drawing applications) require mouse input. WiViK 
therefore includes mouse emulation through a unique 
radar scanning method which rotates the cursor in 
scanning steps. 

WiViK mouse emulation is accessed by selecting the 
Mouse cursor icon on the Text cursor page.

When the highlight contains the target, activate the 
Select switch and the highlight sweeps a smaller 
rotational segment. Repeat this until a straight line is 
rotating. 

	

	

	 	 Home or beginning of line

	 	 Page down

	 	 Page up

	 	 Return to initial letters page

	 	 Extend Select/ Stop Extend select

		  Cut

		  Copy

		  Paste

		  Temporarily hide WiViK; any switch 
action will show WiViK again

		  Undo

		  Display Scanning mouse page

		  Scroll down

		  Scroll up

		  Maximize window

	 	 Restore window

Faster		  Decrease the scan interval by 0.25 
sec.s

Slower		  Increase the scan interval by 0.25 
sec.s

SCANNING THE DESKTOP
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To use the scanning mouse

1.	 Select the Mouse cursor icon on the Text 
cursor page

	 A new WiViK page will be displayed containing 
mouse movement keys.

2.	 Select a cursor rotation key to set the movement 
direction to move. Watch it rotate in a scanning 
steps. 

		   or  or  
	

	 Reduce and eventually stop the rotation by 
activating the Select switch. 

3.	 Select a cursor movement key to move the 
cursor along the chosen direction. Watch it move 
in scannng steps.

	  or  or 

	 Reduce and eventually stop the movement by 
activating the Select switch. 

4.	 Select a button action key as required.

	  or  or  / 

Key descriptions 

	 Scan move ahead by 25, 5 and 1 pixels

	 Scan move ahead by 5 and 1 pixels	

	 Scan move ahead by 1 pixel	

	 Scan move backwards by 1 pixel

	 Scan rotate counterclockwise by 45°, 15°, 5° 
and 1°	

	

	

	

	

This is similar to row/group/item scanning. To use this 
technique, continue activating the switch whenever 
the target is highlighted until it is intersected with a 
straight line.

You then choose a mouse movement key to scan 
towards the target. Mouse movements also incorporate 
successively smaller movements.

When the desired location is reached, select the 
appropriate button (click, double-click, or button down).

SCANNING THE DESKTOP
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2.	 Activate the Select switch to stop at a desired 
menu. That menu will then be scanned from top-
to-bottom.

3	 Activate the Select switch to stop at a desired 
menu item. That item will then be chosen. 

	 The keyboard will then show the Dialogs 
page after any menu selection allowing you to 
respond. (See Dialogs below)

To cancel scanning menus without making a 
selection, activate the Cancel switch. 

Switch applications

To switch between applications

1.	 Select the Application switching icon. 

	 A small window will appear in the middle of 
the screen with the names and icons of the 
application displayed one-by-one in a scanning 
sequence. Activate the Select switch when the 
desired application name is displayed. (This is the 
same as repeatedly typing Alt+Tab.)

	

Alternate WiViK locations

To alternate between WiViK locations

1.	 Select the WiViK location icon. 

	 The first time, drag WiViK to a second position.
WiViK will remember that location. Thereafter, 
WiViK will move to that position when this icon is 
chosen. 

	 Select the icon  again and WiViK will return 
to its first position.

	 Scan rotate counterclockwise by 5° and 1°

	 Scan rotate counterclockwise by 1°

	 Scan rotate clockwise by 1°

	 Single click

	 Double-click

	 Button down/Button up

	 Return to initial letters page

	 Scan menus

	 Scan switch applications

	 Move/resize window

Menus

To scan the Start Menu

1.	 Select the Start Menu icon. 

	 The Start Menu bar will be scanned from Top-to-
bottom.

2.	 Activate the Select switch to stop at a desired 
place. Any sub-menus will be opened and 
scanned.

3	 Activate the Select switch to stop at a desired 
menu item. That item will then be chosen. 

To scan a menu

1.	 Select the Menus icon. 

	 The target application's menu bar will be scanned 
from left-to-right. 

SCANNING THE DESKTOP
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Dialogs

To control a dialog box

1.	 Select the dialogs icon. 

	 The following page of dialog actions is now 
shown:

The dialogs page of commands is shown 
automatically after accessing menus.

Key descriptions
Yes	 Types Alt+y to select Yes button

No	 Types Alt+ n to select No button 

Cancel	 Types Esc to select Cancel button to cancel 
dialog

OK	 Types Enter 

	 Types Enter

	 Scan between dialog tabs  
Use Select or Cancel switch to stop scanning

	 Scan between controls or topics using Tab  
Use Select or Cancel switch to stop scanning

	 Scan right a list or group 

	 Scan left a list or group

	 Scan down a list or group 

	 Scan up a list or group

	 Types Space to select a button or checkbox

Help	 Types F1 to select Help

	 Return to initial letters page

	 Scan move window up

	 Scan move window down

	 Scan move window left

	 Scan move window right

Move/resize windows

To move/resize a window

1.	 Select the Window manipulation icon. 

	 The following page of manipulation keys is now 
shown:

2.	 Select a desired move/resize icon.

	 The window will begin moving/resizing through 
scanning.

3.	 Activate the Select or Cancel switch to stop 
moving/resizing. 

Key descriptions

	 Scan move window up

	 Scan move window down

	 Scan move window left

	 Scan move window right

SCANNING THE DESKTOP
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Key description 

	 Back

	 Forward 

	 Go

	 Search

	 Refresh

	 Stop (esc)

	 Scan Favorites

	 Enter URL Address

	 Use mouse scanning to position cursor; Rotate 
counterclockwise by 45°, 10°, and 1°; Scan 
move ahead by 25 and 3 pixels

	 Single-click

	 Select word at cursor position

	 Select paragraph at cursor position

	 New window tab 

	 Scan across window tabs

	 Close window tab

Aa+	 Increase text size

Aa-	 Decrease text size

	 Scan size top border up

	 Scan size top border Down

	 Scan size left border left

	 Scan size left border right

	 Scan size bottom border up

	 Scan size bottom border down

	 Scan size right border left

	 Scan size right border right

	 Return to initial letters page

	 Minimize window

	 Maximize window

	 Restore window

	 Close window

Internet Explorer

To control Internet Explorer 

1.	 Select the Internet Explorer icon. 

	 The following page of manipulation keys is now 
shown:

SCANNING THE DESKTOP
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Expanding quadrant selection

	

3.	 At this point, words will be predicted. Use the 
same technique to select individual words, return 
to the first page of keys to type another letter, or 
enter a punctuation.

	

This innovative selection method has been developed 
for people with imprecise pointing abilities. Quadrants 
of a keyboard are expanded to provide larger target 
areas for selection. 

Expanding quadrant selection requires the use of a 
.kbq type of keyboard consisting of 64 keys (4 x 4 keys 
in each quadrant). A quadrant is selected by either 
clicking or dwelling.

One quadrant keyboard is included — a letter 
frequency weighted layout with word predictions.

To use expanding quadrant selection

1.	 Open quadpred.kbq located in the \Program 
Files\WiViK\macro subdirectory.

2.	 Point to a quadrant and select it. That quadrant 
expands to fill the keyboard with 4 quadrants of 2 
x 2 keys.	  
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4. 	 From the first page you may choose “…” (at the 
lower-right corner) to access additional functions, 
including controlling WordQ word prediction 
and speech feedback as well as manipulating the 
desktop as in the scanning keyboards.

	

5.	 Punctuation, numbers and function keys are 
available by choosing “…” from the above page.

To go back if the wrong quadrant is 
chosen

	 Point at the keyboard and click with the right 
mouse button or equivalent switch to escape to 
the previous level. 

EXPANDING QUADRANT SELECTION
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crnfreq.kbm	 Frequency-of-use layout starting 
in the upper left-hand corner for 
Automatic or Inverse Row-Column 
Highlighting scanning and with 
predicted words along left column

crnfreqtop.kbm	 Frequency-of-use layout starting 
in the upper left-hand corner for 
Automatic or Inverse Row-Column 
Highlighting scanning and with 
predicted words along top row

linabc.kbm	 Single line ABC layout for Group-Item 
scanning for Automatic or Inverse 
Row-Column-Group scanning

linfreq.kbm	 Single line frequency-of-use layout for 
Group-Item scanning for Automatic 
or Inverse Row-Column-Group 
scanning

simpabc.kbm	 Simple reduced set ABC layout 
starting in the upper left-hand corner 
for Automatic or Inverse Row-
Column scanning

Directed scanning keyboards

ctrabc.kbm	 ABC layout for Directed scanning 
with Switch selection

ctrfreq.kbm	 Center-based frequency-of-use layout 
for Directed scanning with Switch 
selection

ctrfreqtop.kbm	 Center-based frequency-of-use layout 
for Directed scanning with Switch 
selection and with predicted words 
along top row

ctrfreq2.kbm	 Center-based frequency-of-use layout 
for Directed scanning with Dwell 
selection

ctrfreq2top.kbm	 Center-based frequency-of-
use layout for Directed scanning with 
Dwell selection and with predicted 
words along top row

Appendix A: Macro Keyboards

General use macro keyboards

allchar.kbm	 All extended ASCII characters 
available in Windows

calc.kbm	 Calculator keyboard

interntl.kbm	 Keyboard of all ANSI international 
characters available under Windows 
by entering the numeric keypad 
codes as described in the Windows 
documentation

keystrke.kbm	 Keyboard of all possible non-
character keystrokes

menuaccs.kbm	 Keyboard that allows you to 
manipulate another WiViK’s menus

numpad.kbm	 Numeric keypad with cursor 
movement keys

numpad2.kbm	 Numeric keypad 

playsnd.kbm	 Keyboard illustrating keys that play 
.wav sounds

sci-calc.kbm	 Keyboard for use with Calculator in 
Scientific mode

typogrph.kbm	 Typographical characters such as 
bullets, curly quotes, en and em 
dashes, trademark and copyright 
symbols

wvksym.kbm	 Keyboard illustrating keys that use 
WiViK font for displaying certain 
keyboard symbols

Automatic/inverse scanning 
keyboards

crnabc.kbm	 ABC layout starting in the upper left-
hand corner for Automatic or Inverse 
Row-Column Highlighting scanning
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simpctr.kbm	 Simple reduced set center-based 
frequency-of-use layout for Directed 
scanning with Switch selection and 
with predicted words along left 
column	

simpctrtop.kbm	Simple reduced set center-based 
frequency-of-use layout for Directed 
scanning with Switch selection and 
with predicted words along top row

simpctr2.kbm	 Simple reduced set center-based 
frequency-of-use layout for Directed 
scanning with Dwell selection and 
with predicted words along left 
column

simpctr2top.kbm	 Simple reduced set center-
based frequency-of-use layout 
for Directed scanning with Dwell 
selection and with predicted words 
along top row

Opening and saving select options

When you quit or exit WiViK, all of the select options 
settings are automatically saved. In addition, you can 
save the settings independently in separate files. This 
is useful if you are adjusting settings for several WiViK 
users. 

To save the select options

•	 Select Save Select Options… from the File menu.

•	 Type in a name to save the file, e.g., user’s name 
in the Save Select Options… dialog.

To open previously saved select options

•	 Select Open Select Options… from the File 
menu.

•	 Select a file in the Open Select Options dialog.

All Select Options files have the ending .sel. 
 
When you later close the WiViK keyboard, the 
settings that you opened will automatically be 
saved with that keyboard.	

Select Options Files

The following is a list of the sample Select Options 
files provided in the \wivik subdirectory. They should 
be used with the keyboard configurations listed next 
to them. You may modify any of these settings and/or 
create your own Select Option settings.

File	 Strategy	 Switches 
Description	

aut2lin.sel	 automatic	 2	 row-group-
item	 for linear 
keyboards	

aut2quad.sel	 automatic	 2	 quadrant		

autcon.sel	 automatic	 2	 row-column	
continuous scan	

autstop.sel	 automatic	 2	 row-column	
stop scan	

dir3rcw.sel	 directed	 3	 return to 
corner toggling 
directions	

dir4rcd.sel	 directed	 4	 return to centre	
	 dwell select	

dir5nr.sel	 directed	 5	 no return	
		
switch select	

dir5rc.sel	 directed	 5	 return to centre	
	 switch 
select	

inv2lin.sel	 inverse	 2	 row-group-
item	 for linear 
keyboards	

invdwc.sel	 inverse	 3	 row column	
dwell cancel		
move-fast switch

invswc.sel	 inverse	 3	 row column	
cancel switch

MACRO KEYBOARDS
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Appendix B: Additional wivik3.ini Settings

Several features have settings that you must manually 
change in wivik3.ini, located in the Windows (or 
WinNT) directory, if you do not like the default setting. 
These features are not set in any WiViK menu or dialog 
box. They are described below.

Feature	 Setting 	Description

MoveDialog	 1	 (Default) WiViK will 
attempt to move 
dialog boxes if they are 
completely obscured 
by WiViK, or if they 
completely obscure WiViK

	 0	 Dialog boxes are not 
moved by WiViK

MoveOnTop	 1	 (Default) WiViK will 
attempt to move on top 
of the dialog boxes and 
menus

	 0	 WiViK will not attempt to 
move on top

TransferFocus	 1	 (Default) Focus will 
automatically be 
transferred from WiViK 
back to the target 
application

	 0	 Focus will not be 
automatically transferred 
back

ExtraInfoMessages	 1	 (Default) On hiding the 
title bar, you will be 
prompted with a message 
indicating that double 
clicking any border will 
restore it; and when word 
prediction shifts to a new 
keyboard, you will be 
informed

	 0	 Additional message 
prompts will not be 
displayed.

QuadrantHighlight	 1	 Quadrants will be 
highlighted by being 
outlined

	 0	 (Default) Quadrants will 
be highlighted by being 
inverted

To modify wivik3.ini

1.	 Open wivik3.ini using Notepad.

2.	 Change the desired settings.

3.	 Save wivik3.ini. Your changes will be in effect 
the next time that you open up a changed WiViK 
keyboard.

Example

[** DEFAULT **]

...

MoveDialog=0

MoveOnTop=1

TransferFocus=1

ExtraInfoMessages=0

QuadrantRBUndoString=0

QuadrantHighlight=0

...
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Appendix C: Standard Keystrokes

These functions perform standard keyboard actions. 
You may include them in your in both key macros as 
well as abbreviation-expansions. *Sticky and Toggle 
modifier keys are used in combination with other 
macro keys (without providing any visual feedback as 
to their state).

Macro key	 Description

<SHIFT>	 *Sticky Shift
<CTRL>	 *Sticky Ctrl
<RCTRL>	 *Sticky Right  Ctrl
<ALT>	 *Sticky Alt 	
<RALT>	 *Sticky Right Alt
<ALTGR>	 *Sticky Alt Gr 
<ENTER>	 Enter/Return
<ESC>	 Escape (Esc)
<CAPSLOCK>	 *Toggle CapsLock
<NUMLOCK>	 *Toggle NumLock
<SCROLLLOCK> 	*Toggle ScrollLock
<PAUSE>	 Pause
<PRTSC>	 Print Screen
<INS>	 Insert
<DEL>	 Delete (forward)
<HOME>	 Home
<END>	 End
<PGUP>	 Page Up
<PGDN>	 Page Down
<BKSP>	 Backspace
<SPC>	 Space
<TAB>	 Tab
<UP>	 Up Arrow
<DOWN>	 Down Arrow
<LEFT>	 Left Arrow
<RIGHT>	 Right Arrow

<F1>	 Function Key 1
<F2>	 Function Key 2
<F3>	 Function Key 3
<F4>	 Function Key 4
<F5>	 Function Key 5
<F6>	 Function Key 6
<F7>	 Function Key 7
<F8>	 Function Key 8
<F9>	 Function Key 9
<F10>	 Function Key 10
<F11>	 Function Key 11
<F12>	 Function Key 12
<F13>	 Function Key 13
<F14>	 Function Key 14
<F15>	 Function Key 15
<F16>	 Function Key 16
<KP*>	 * (keypad)
<KP+>	 + (keypad)
<KP->	 -(keypad)
<KP/>	 / (keypad)
<KP0>	 0 (keypad)
<KP1>	 1 (keypad)
<KP2>	 2 (keypad)
<KP3>	 3 (keypad)
<KP4>	 4 (keypad)
<KP5>	 5 (keypad)
<KP6>	 6 (keypad)
<KP7>	 7 (keypad)
<KP8>	 8 (keypad)
<KP9>	 9 (keypad)
<KPDP>	 Decimal Point (keypad)
<KPENTER>	 Enter/Return (keypad)
<KPDEL>	 Delete (.) (keypad)
<KPINS>	 Insert (0) (keypad)
<KPEND>	 End of line (1) (keypad)
<KPDOWN>	 Down (2) (keypad)
<KPPGDN>	 Page Down (3) (keypad)
<KPLEFT>	 Left (4) (keypad)
<KPMIDL>	 Middle (5) (keypad)
<KPRIGHT>	 Right (6)
<KPHOME>	 Home (7)
<KPUP>	 Up (8)
<KPPGUP>	 Page Up (9)
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End-User License Agreement for WiViK  
On-Screen Keyboard Software
Version 3 for use with Microsoft Windows

IMPORTANT - READ THIS AGREEMENT CAREFULLY BEFORE 
INSTALLING OR USING THIS PRODUCT:

This End-User License Agreement (“EULA”) is a legal agreement 
between you (either an individual or a single entity) and Prentke 
Romich Company (“PRC” or “Licensor”), for the WiViK on-screen 
keyboard software and other accompanying software, data 
or computer programs that may be included as components 
(including WordQ Writing Aid Software), and which may also include 
associated media, printed materials, and “online” or electronic 
documentation (“Documentation”) (collectively, “SOFTWARE 
PRODUCT”).  BY INSTALLING, COPYING, OR OTHERWISE USING THE 
SOFTWARE PRODUCT, YOU AGREE TO BE BOUND BY THE TERMS OF 
THIS EULA. IF YOU DO NOT AGREE TO THE TERMS OF THIS EULA, 
THEN DO NOT INSTALL OR USE THE SOFTWARE PRODUCT.  YOU 
MAY, HOWEVER, RETURN IT TO YOUR PLACE OF PURCHASE FOR A 
FULL REFUND.

TITLE AND COPYRIGHT

The SOFTWARE PRODUCT is licensed for manufacture, copying 
and distribution by PRC from Quillsoft Ltd. (“Quillsoft”) (250 The 
Esplanade, Unit 308, Toronto, Ontario M5A 1J2). Quillsoft and 
its licensors own all right, title and interest including all patent, 
copyright, trade-mark, trade secret and any other intellectual 
property and proprietary rights in and to the SOFTWARE PRODUCT. 
Therefore, you must treat the SOFTWARE PRODUCT like any other 
copyrighted and proprietary material. By accepting this EULA, 
you acknowledge and agree that all of the foregoing intellectual 
property rights in the SOFTWARE PRODUCT are owned by and 
remain with Quillsoft and its licensors, and that you will not do 
anything to contest or prejudice Quillsoft's or its licensors’ title to 
any such rights in the SOFTWARE PRODUCT. 

SOFTWARE PRODUCT LICENSE

The SOFTWARE PRODUCT is protected by copyright laws and 
international copyright treaties, as well as other intellectual 
property laws and treaties. The SOFTWARE PRODUCT is licensed, 
not sold.

1) 	 GRANT OF LICENSE

This EULA grants you, the registered computer software user, the 
following rights:

•	 APPLICATIONS SOFTWARE. You may install and use one (1) copy 
of the SOFTWARE PRODUCT, or any prior version thereof for 
the same operating system, on a single computer (or network, 
subject to the terms below), unless you have been granted 
express permission by Licensor to install and use the SOFTWARE 
PRODUCT on additional computers. You may only use the 
SOFTWARE PRODUCT in the number of written languages, 
if more than one is available, for which you have acquired 
rights from the Licensor and which you selected at time of first 
installation. The SOFTWARE PRODUCT may be used only by you. 
You may make one copy of the SOFTWARE PRODUCT for archival 
or backup purposes only.

•	 INSTALLATION. The SOFTWARE PRODUCT is distributed to you 
on self-installing media as described in the Documentation. 
You will need to install the SOFTWARE PRODUCT on properly 
configured and compatible computer equipment according 
to the Documentation. You will also need to ensure that all 
required data is in proper format and no other software or 
equipment having an adverse impact on the SOFTWARE 
PRODUCT are present on your computer equipment. You will 
be required to submit an unlocking serial number during 
the installation procedure, which is provided in the materials 
included in your software package.

•	 STORAGE/NETWORK USE. You may alternatively store or install 
a copy of the SOFTWARE PRODUCT on a storage device, such 
as a network server, used only to install or run the SOFTWARE 
PRODUCT on your computers over an internal network; however, 
you must acquire and dedicate a distinct license for each user 
using the SOFTWARE PRODUCT from the storage device. Any 
given license for the SOFTWARE PRODUCT may not be shared 
or used concurrently or otherwise on different computers or 
by different users within your organization. The LICENSED 
SOFTWARE may not be simultaneously installed on a single 
computer and a network server without obtaining a distinct 
license for each such installation.

•	 EVALUATION PERIOD. If you have received this software as 
a “Demonstration Version” (i.e., without the purchase of an 
unlocking serial number), and once you accept this EULA, you 
will obtain a temporary “Evaluation License” to install, use and 
evaluate one (1) copy of the SOFTWARE PRODUCT for thirty (30) 
days. The Evaluation License does not authorize you to make 
commercial use of the SOFTWARE PRODUCT (which commercial 
use includes, without limitation, use for business purposes 
or creation of publicly distributed documents). At the end of 
the Evaluation Period, the SOFTWARE PRODUCT will cease to 
function and must be uninstalled unless you obtain a license 
to use the SOFTWARE PRODUCT according to this EULA by 
agreeing to pay the license fee for the SOFTWARE PRODUCT. 
Any use of the SOFTWARE PRODUCT beyond the Evaluation 
Period without such license is a breach of this EULA and may be 
a violation of international copyright laws.

2) 	 DESCRIPTION OF OTHER RIGHTS AND LIMITATIONS

•	 ACADEMIC EDITION SOFTWARE. If the SOFTWARE PRODUCT is 
identified as “Academic Edition” or “Educational Copy” or “AE,” 
you must be a “Qualified Educational User”, as determined by 
Licensor and/or Quillsoft, to use the SOFTWARE PRODUCT. If you 
are a Qualified Educational User, you may be granted express 
rights that differ from this EULA, in which case all terms and 
conditions of this EULA not inconsistent with those expressly 
communicated to you at the time of purchase apply equally to 
you. If you are not a Qualified Educational User, you have no 
rights under this EULA unless you pay the remaining license fees 
payable by a normal user under this EULA. To determine whether 
you are a Qualified Educational User, please contact the Licensor 
at the address below.
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•	 LIMITATIONS ON REVERSE ENGINEERING, DECOMPILATION, AND 
DISASSEMBLY. You may not reverse engineer, decompile, or 
disassemble the SOFTWARE PRODUCT, except and only to the 
extent that such activity is expressly permitted by applicable law 
notwithstanding this limitation. 

•	 GENERAL RESTRICTIONS. You may not use the SOFTWARE 
PRODUCT or make copies of it except as expressly permitted 
in this EULA.  Without limiting the generality of the foregoing, 
you may not modify, translate or, except as expressly permitted 
herein, copy the SOFTWARE PRODUCT. The SOFTWARE 
PRODUCT is licensed as a single product. Its component parts 
may not be separated for use on more than one computer. You 
may not modify the SOFTWARE PRODUCT or merge all or any 
part thereof with another program.

•	 NOT FOR RESALE SOFTWARE. If the SOFTWARE PRODUCT is 
labeled “Not for Resale” or “NFR” or “Demonstration Copy”, 
then, notwithstanding other sections of this EULA, you may not 
make commercial use of the SOFTWARE PRODUCT nor sell, or 
otherwise transfer it for value. Commercial use includes, without 
limitation, use for business purposes or creation of publicly 
distributed documents.

•	 RENTAL. You may not rent, lease, lend, assign or transfer the 
SOFTWARE PRODUCT to any party except as expressly permitted 
in this EULA or without written permission by the Licensor.

•	 SOFTWARE TRANSFER. You may permanently transfer all of your 
rights under this EULA, provided you (a) retain no copies, (b) 
transfer all of the SOFTWARE PRODUCT (including all component 
parts, Documentation, the media and printed materials, any 
upgrades and this EULA), and (c) the recipient agrees in writing 
to abide by all of the terms of this EULA. If the SOFTWARE 
PRODUCT is an upgrade, any transfer must include all prior 
versions of the SOFTWARE PRODUCT and all of your licensed 
rights therein, if any.

3) 	 SUPPORT SERVICES

PRC may provide you with support services related to the most 
recent version of the SOFTWARE PRODUCT (“Support Services”). 
Quillsoft is under no obligation to provide or perform any 
installation, training, maintenance, support or other Support 
Services to you.

Any supplemental software code provided to you as part of the 
Support Services shall be considered part of the SOFTWARE 
PRODUCT and subject to the terms and conditions of this EULA. 
With respect to technical information you provide to PRC as part of 
the Support Services, PRC and/or Quillsoft may use such information 
for its technical and business purposes, including for product 
updates and development. PRC and Quillsoft will not utilize such 
technical information in a form that personally identifies you.

•	 ON-LINE SERVICE. You may obtain assistance for error correction 
and advice on the use and operation of the most current 
version of the SOFTWARE PRODUCT through the online system 
designated in the Documentation or otherwise identified to you 
by the Licensor. If you submit a request for technical support 
you will need to provide sufficient information for Licensor to 
replicate and diagnose the reported problem. 

•	 UPDATES. You may obtain copies of each revision to the 
SOFTWARE PRODUCT and/or Documentation that Licensor 
generally distributes to the public (“Update”) by paying prices 
from time to time announced by Licensor, if any, or as otherwise 
indicated by Licensor. The Licensor’s designation of an item as 

a new version or an enhancement rather than an Update shall 
be conclusive. Updates may be available on diskette, or CD, or 
as a download from Licensor’s designated online system. You 
agree to install all Updates promptly, since the Licensor will 
only provide Product Support for the most recent version of the 
SOFTWARE PRODUCT, incorporating all prior Updates.

•	 CERTAIN CONDITIONS. Licensor shall not be obligated to 
provide Product Support if: (i) the reported error was caused 
by unauthorized changes in SOFTWARE PRODUCT source code, 
object code, program parameters or other user adjustable 
features; (ii) the error results from operator error, errors in data 
or software not supplied by Licensor or use that is not expressly 
permitted under this EULA or is not in accordance with the 
Documentation, or (iii) the error is in a prior release that was 
corrected through issuance of an Update that you have not yet 
installed.

•	 TERMINATION. Without prejudice to any of the Licensor’s other 
rights, this EULA and the license granted herein shall terminate 
automatically if you fail to comply with the terms and conditions 
of this EULA. No notice will be required from the Licensor to 
effect termination of this EULA. Upon termination, you must 
immediately discontinue use of the SOFTWARE PRODUCT and 
destroy all copies of the SOFTWARE PRODUCT and all of its 
component parts and any related materials including, without 
limitation, the Documentation.

4) 	 PRICE AND PAYMENT

•	 PRICE. You agree to pay Licensor or its distributor, as the case 
may be, the applicable license fee determined by reference to 
Licensor’s published prices at the time this SOFTWARE PRODUCT 
was ordered. Payment of the license fee entitles you to use the 
SOFTWARE PRODUCT in accordance with this EULA until such 
license is terminated as described herein.

•	 PAYMENT. Unless otherwise stated on Licensor’s or its 
distributor’s invoice, the applicable fees and shipping charges 
are payable by you promptly upon delivery. You will pay all sales, 
use, value-added, GST, personal property or other governmental 
tax or levy associated with this transaction (including interest 
and penalties imposed thereon) other than taxes based on the 
net income or profits of Licensor or its distributors. If you fail to 
pay any amount when due, your license to Use the SOFTWARE 
PRODUCT will automatically terminate and you will pay all costs 
of enforcement, including reasonable legal fees. 

5) 	 LIMITED WARRANTY

PRC WARRANTS THAT THE MEDIA ON WHICH THE SOFTWARE 
PRODUCT IS SUPPLIED WILL BE FREE OF DEFECTS IN MATERIALS AND 
WORKMANSHIP FOR 90 DAYS FROM THE DATE YOU ACQUIRE IT. IN 
THE EVENT OF SUCH DEFECT WITHIN THE STATED PERIOD, PRC WILL 
PROVIDE TO YOU, AT NO CHARGE, A REPLACEMENT COPY OF THE 
SOFTWARE PRODUCT UPON RETURN OF ANY DEFECTIVE MEDIA. 
THIS REMEDY IS YOUR EXCLUSIVE REMEDY FOR BREACH OF THIS 
WARRANTY.

EXCEPT FOR THE EXPRESS WARRANTY IMMEDIATELY ABOVE, 
THE SOFTWARE PRODUCT IS PROVIDED “AS IS”.  NEITHER PRC 
NOR QUILL GIVE ANY OTHER WARRANTIES, REPRESENTATIONS 
OR CONDITIONS OF ANY KIND, EXPRESS OR IMPLIED, WITH 
RESPECT TO THE SOFTWARE PRODUCT, INCLUDING ANY UPDATES 
THERETO, ITS OPERATION, PERFORMANCE, FUNCTIONS, DATA 
OR DOCUMENTATION, INCLUDING WITHOUT LIMITATION ANY 
WARRANTIES, REPRESENTATIONS OR CONDITIONS THAT IT WILL 
MEET YOUR REQUIREMENTS, THAT THE OPERATION OF THE 

LICENSE AGREEMENT
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SOFTWARE PRODUCT WILL BE UNINTERRUPTED, ERROR OR VIRUS 
FREE, THAT PROGRAMMING ERRORS CAN BE CORRECTED OR 
FOUND, OR IMPLIED WARRANTIES OF MERCHANTABLE QUALITY, 
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE OR NON-
INFRINGEMENT OF THIRD PARTY RIGHTS, OR THOSE ARISING BY 
LAW, STATUTE, USAGE OF TRADE OR A COURSE OF DEALING.

THIS LIMITED WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS, AND 
YOU MAY HAVE OTHER RIGHTS, WHICH VARY ACCORDING TO LOCAL 
LAWS. BECAUSE SOME STATES AND PROVINCES DO NOT ALLOW THE 
EXCLUSION OR LIMITATION OF IMPLIED WARRANTIES, THE ABOVE 
WARRANTY EXCLUSIONS OR LIMITATIONS MAY NOT APPLY TO YOU.  
THIS SECTION WILL SURVIVE TERMINIATION OF THIS AGREEMENT.

6) 	 LIMITATION OF LIABILITY

IN NO EVENT SHALL PRC OR QUILLSOFT OR THEIR RESPECTIVE 
OFFICERS, DIRECTORS, EMPLOYEES, AGENTS, REPRESENTATIVES, 
DISTRIBUTORS OR RESELLERS BE LIABLE FOR ANY LOST PROFITS 
OR REVENUES, LOST SAVINGS, BUSINESS INTERRUPTION, LOSS 
OF INFORMATION, OR ANY INDIRECT, SPECIAL, INCIDENTAL, OR 
CONSEQUENTIAL DAMAGES OF ANY KIND ARISING OUT OF THE USE 
OF OR INABILITY TO USE THE SOFTWARE PRODUCT EVEN IF PRC 
OR QUILLSOFT HAVE BEEN ADVISED OF THE POSSIBILITY OF SUCH 
DAMAGES. PRC AND QUILLSOFT'S MAXIMUM AGGREGATE LIABILITY 
TO YOU SHALL NOT EXCEED THE AMOUNT OF THE LICENSE FEE PAID 
BY YOU (IF ANY) FOR THE SOFTWARE PRODUCT.

THE LIMITATIONS, EXCLUSIONS AND DISCLAIMERS IN THIS 
AGREEMENT SHALL APPLY IRRESPECTIVE OF THE NATURE OF THE 
CAUSE OF ACTION OR DEMAND, INCLUDING BUT NOT LIMITED 
TO BREACH OF CONTRACT, NEGLIGENCE, TORT OR ANY OTHER 
LEGAL THEORY, AND SHALL APPLY WHETHER OR NOT THE ALLEGED 
BREACH OR DEFAULT IS A FUNDAMENTAL BREACH AND/OR FAILURE 
OF THE ESSENTIAL PURPOSE OF THIS AGREEMENT OR OF ANY 
REMEDY CONTAINED IN THIS AGREEMENT. BECAUSE SOME STATES 
AND PROVINCES DO NOT ALLOW THE EXCLUSION OR LIMITATION 
OF LIABILITY FOR CONSEQUENTIAL OR INCIDENTAL DAMAGES, THE 
ABOVE EXCLUSIONS OR LIMITATIONS MAY NOT APPLY TO YOU. THIS 
SECTION WILL SURVIVE TERMINIATION OF THIS AGREEMENT.

7) 	 GOVERNING LAW

This EULA shall be governed by and construed in accordance 
with the laws of the Province of Ontario and the laws of Canada 
applicable therein.  You agree to submit to the non-exclusive 
jurisdiction of the courts of the Province of Ontario.  The parties 
hereby exclude the applicability of the U.N. Convention on 
Contracts for the International Sale of Goods.

8) 	 EXPORT REGULATIONS

The transfer of technology across national boundaries is regulated 
by the U.S. Government. You agree not to export or re-export the 
SOFTWARE PRODUCT without first obtaining any required export 
license or governmental approval. You will not directly or indirectly 
export or re-export (including by transmission) any regulated 
technology to any country to which such activity is restricted by U.S. 
regulation or statute, without the prior written consent, if required, 
of the Bureau of Export Administration of the U.S. Department of 
Commerce. This provision and the assurances made herein shall 
survive termination of this EULA.

9) 	 U.S. GOVERNMENT RESTRICTED RIGHTS

The SOFTWARE PRODUCT (including Documentation) is provided 
with RESTRICTED RIGHTS. Use, duplication or disclosure by the 
Government is subject to restrictions as set forth in the Rights in 
Commercial Computer Software clause at DFARS 227.7202-3 or 
subparagraphs (c)(1) and (2) of the Commercial Computer Software 
- Restricted Rights clause at 48 CFR 52.227-19, as applicable. The 
Contractor/manufacturer is Prentke Romich Company, with offices 
at 1022 Heyl Road,Wooster, OH 44691, USA.

10) 	  MISCELLANEOUS

This EULA constitutes the entire and exclusive agreement 
between the parties with respect to the subject matter hereof and 
supersedes all other agreements, representations, discussions and 
communications, whether written or oral. This document and your 
acceptance of this agreement through installation of the SOFTWARE 
PRODUCT shall be considered an original document admissible 
into evidence unless the document’s authenticity is genuinely 
placed in question. You may issue a purchase order, but it will have 
no substantive effect on our EULA. This EULA may be modified or 
amended only by a writing signed by an authorized representative 
of Licensor. It is agreed that sales representatives and distributors of 
the SOFTWARE PRODUCT have no authority to alter this EULA. Any 
provision found by a tribunal of competent jurisdiction to be illegal 
or unenforceable shall be automatically conformed to the minimum 
requirements of law and all other provisions shall remain in full 
force and effect. Waiver of any provision hereof in one instance 
shall not preclude enforcement of it on future occasions. Headings 
are for reference purposes only and have no substantive effect. 
The parties have requested that this Agreement and all documents 
contemplated hereby be drawn up in English. Les parties aux 
présentes ont exigé que cette entente et tous autres documents 
envisagés par les présentes soient rédigés en anglais.

ADDRESS INFORMATION

Prentke Romich Company 
1022 Heyl Road 
Wooster, OH 44691 
USA

Web site: http://www.prentrom.com

Quillsoft Ltd. 
208 The Esplanade, Unit 308 
Toronto, ON M5A 1J2 
CANADA 

Web site: http://www.wivik.com

WiViK, WordQ and SpeakQ software were originally developed by 
Holland Bloorview Kids Rehabilitation Hospital with support from 
the Ontario Rehabilitation Technology Consorium and htx.ca The 
Health Exchange and Quillsoft Ltd. May include and use text-to-
speech technology licensed from Acapela. 

© 1991-2010  Holland Bloorview Kids Rehabilitation Hospital. All 
Rights reserved. 

© 2011  Quillsoft Ltd. All Rights reserved. 

WiViK, WordQ and SpeakQ are registered trademarks of Quillsoft 
Ltd.
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